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CAMPAIGN IMAGE REQUIREMENTS 

No call to action Unclear that content is clickable Lacks customized branding 

Image only Logo only 

Try to avoid: 

Plain text 

Ride-along Image 
USPS® requires that Informed Delivery campaigns include 

full color interactive content that accompanies the scanned 

mailpiece or Representative Image (see page 2). When 

users select the Ride-along Image, visible in a daily digest 

email or on the dashboard, they are redirected to 

the target URL. 

This supplemental content is meant to enhance the 
customer call-to-action and reinforce the business objective 
of the mailpiece. For optimal quality within the digital setting, 
follow the recommendations and requirements below: 

• Sync the look of the Ride-along Image to the mailpiece
or Representative Image presented.

• Treat the Ride-along Image like a branded, clickable
button with a call-to-action.

• Opt for a clean, simple layout.

• Provide a direct URL (must start with https).

• Target URL must lead directly to a landing page
associated with the physical mailpiece.

• Size to at least one maximum dimension: 300px width
or 200px height.

Logo 
reinforces 
brand 

Reverse type on solid color is 
clean and legible 

200px 

Look and 
message 
sync to 
mailpiece 

Required: 

300px Call-to-action 
is clear and 
compelling 

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size
• Image color code must be RGB (not CMYK)

“Retailer Name” is not an actual company and is for illustrative purposes only. 7.2020 

Ride-along 
Image 

FROM Retailer 
Name 

Scanned 
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Try to avoid: 
Lacks mailpiece details Grayscale 

Correlation to mailpiece is lost Lacks customized branding 

Representative Image 
USPS® allows you to enhance your Informed Delivery 
campaign with a full color image that displays in place of 
the scanned mailpiece (i.e., letters and postcards). Users 
can view this content in a daily digest email or on their 
dashboard. 

Don’t miss an opportunity to use the production art created 
for your mail campaign. For optimal quality within the digital 
setting, follow the below recommendations and 
requirements. 

• Use a color image of the mailpiece so users correlate
the digital image.

Note: The image must be branded and directly related to the 

mailpiece and its contents.

• Sync the look of the Representative and Ride-
along Images to each other for a cohesive
experience.

• Size to at least one maximum dimension: 780px width
or 500px height.

Color image of the mailpiece 

500px 
max 
height 

Look and feel match 
the Ride-along Image 

Required: 

780px max width 

Use at least one 
maximum image 
parameter 

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size

• Image color code must be RGB (not CMYK)

“Retailer Name” is not an actual company and is for illustrative purposes only. 7.2020 

Ride-along Image 

FROM Retailer Name 

Learn More 

Representative Image 
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Lacks brand colors Correlation to mailpiece is lost 

Grayscale Lacks mailpiece details 
Try to avoid: 

Representative Image - Flats 
USPS® requires you to conduct an Informed Delivery 

campaign using a full color image in lieu of your mailpiece 

(i.e., catalogs and magazines). Users can view this content in 

a daily digest email or on their dashboard. 

Don’t miss an opportunity to use the cover art created 

for your latest mailing in a digital preview of incoming mail. 

For optimal quality within the digital setting: 

• Use a color image of the mailpiece so users correlate
the digital image.

Note: The image must be branded and directly related to the 

mailpiece and its contents.

• Sync the look of the Representative and Ride-
along Images to each other for a cohesive
experience.

• Size to at least one maximum dimension: 780px width
or 500px height.

Color image of the mailpiece 

500px 
max 
height 

Look and feel match 
the Ride-along Image 

Required: 

780px max 
width Use at least one 

maximum image 
parameter 

• Save file as a JPEG (.jpg)

• File cannot exceed 200KB in size

• Image color code must be RGB (not CMYK)

“Retailer Name” is not an actual company and is for illustrative purposes only. 7.2020 

Representative Image 

FROM Retailer Name 

Learn More 

Ride-along Image 
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Need Help? 
Verifying Image Dimensions 

To determine whether a Ride-along or Representative Image meets the size requirements, follow the steps below. 

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Open image in Paint: Right click on the image file, select “Open with,” and select “Paint” from the options provided.

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the

Home tab and choosing “Select all.” You will see a dashed line appear around the edge of the image.

4. Click the “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will

open the “Resize and Skew” window.

5. Verify image dimensions: Select “Pixels” next to the By field. The image dimensions should appear. Horizontal

corresponds to width and vertical corresponds to height.

Ride-along Image: 
Horizontal cannot exceed 300px 

Representative Image: 
Horizontal cannot exceed 780px 

Does your image exceed 
size requirements? 

Follow the steps on the 
next page to learn how to 
resize your images… 

Ride-along Image: 
Vertical cannot exceed 200px 

Representative Image: 
Vertical cannot exceed 500px 



Informed Delivery®

CAMPAIGN IMAGE REQUIREMENTS 

Need Help? 
Resizing Images - Option 1 

To resize a Ride-along or Representative Image that does not meet the size requirements, follow the steps below. 

Steps 1-4 are the same as the “Verifying Image Dimensions” steps. 

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Open image in Paint: Right click on the image file, select “Open with,” and select “Paint” from the options provided.

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the

Home tab and choosing “Select all.” You’ll see a dashed line appear around the edge of the image.

4. Click the “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will

open the “Resize and Skew” window.

5. Use the “Resize” fields to change the size of the image: Change the size by typing in the new pixel size (values)

desired. Important Note: Making an image larger than the original will result in a lower-quality picture. Leaving the

“Maintain aspect ratio” option selected ensures the image is not distorted.

Type in the new pixel size that is 
within the size requirements 
for the Ride-along or 
Representative Image. 

“Maintain aspect ratio” 
ensures the image is not 
distorted when resizing. 

6. Click “OK” to see your resized image: The image will be resized according to the values you entered.

7. Remove the excess canvas: The image will be resized, but the white canvas it is on will stay the original size.

• Click and drag the edges of the canvas to resize it (see below), which removes the excess white space.

• Or, use the “Crop” function in the Home tab to remove the extra canvas. Press CTRL + A to select the entire

image to start. Then, select “Crop,” click and drag to highlight only the area around the resized image, and select

“Crop” again. The excess white space should disappear, and the canvas should match the resized image.

8. Save the resized image: Once the image is resized (and you confirm the size requirements are met), save the file.

Select “Save As” from the File tab and choose “JPEG picture.” Then, name the file and choose where you want to

save it.
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Need Help? 
Resizing Images - Option 2 

To resize a Ride-along or Representative Image that does not meet the size requirements, follow the steps below. 

Steps 1-4 are the same as the “Verifying Image Dimensions” steps. 

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Visit an image resizing website: Search “resize jpeg” to find a variety of websites that will help you resize images

for free.

3. Upload the JPEG file you want to resize: Select and upload the file you want to resize.

4. Use the resizing controls to change the size of the image: Each website has a different set of controls to adjust

the image size. Options include clicking and dragging a box, using sliders to adjust the size, or entering the exact

pixel dimensions. When possible, enter the exact pixel dimensions desired and click “Save” or “Resize image.”

Important Note: Making an image larger than the original will result in a lower-quality picture. To avoid losing quality,

maintain the aspect ratio.

5. Download the resized image: Once you resize your image, save the changes to the file. Select “Save As” and

choose “JPEG picture.” Then name the file and choose where to save it.
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Need Help? 
Tips to Determine Color Code 

To determine the color code of a Ride-along or Representative Image, follow the steps below. 

1. Make a copy: Create a copy of your image file so you do not lose the original.

2. Convert the image to a PDF: Locate the image file on your computer and right click on the file. Select the “Convert

to PDF” option.

3. Navigate to Print Production: Locate the tool bar that lists “Home,” “Tools,” and “Document.” Select “Tools” and

scroll until you find “Print Production.” Select this option. Important Note: The location of the “Print Production” option

may differ depending on the application you are using.

4. Verify color code: Identify and select “Output Preview” from the menu. On the pop-up menu that appears, under the

“Show” drop down, select RGB. If the image contains CMYK (Cyan Magenta Yellow Black) elements, these

elements will disappear from the image. If there are no CMYK elements, there will be no change to the image.

Don’t see a change after selecting “RGB”? 
This means that your image is in the required 
color code and does not need to be reformatted. 

5. (Optional) Reformat image: If the image contains CMYK elements, the image owner will need to convert the color

code to RGB before the image can be used for an interactive campaign. Official image editing software may be

required to convert color code.
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Legal Terms 
INFORMED DELIVERY® INTERACTIVE CAMPAIGNS: MAILER/SUBMITTER 

TERMS AND CONDITIONS OF USE AGREEMENT (JANUARY 2020) 

This Terms of Use Agreement (this "Agreement") is a legal agreement between You and the United States Postal 
Service, an Independent Establishment of the Executive Branch of the United States Government ("USPS" or "Postal 
Service"). Informed Delivery interactive campaigns (used herein as “Campaigns”) are at this time a free enhancement 
available to Mailers to the Informed Delivery notifications USPS provides to participating consumers for no additional 
postage fees. “Mailer(s),” “You” and “Your”, as used herein, include the Mail Owner/Brand, and any Mail Service 
Provider and any Advertising Agency acting on behalf of a Mail Owner/Brand in connection with the creation and 
submission of Content for an Informed Delivery Campaign. 

Mailers agreeing to these Terms and Conditions, and complying with other requirements and specifications as may be 
published by USPS in PostalOne!, the Mailer Campaign Portal, in the Informed Delivery Interactive Campaign Guide 
available at https://www.usps.com/business/informed-delivery.htm, or elsewhere on that site, may submit 
supplemental content (“Content”) to accompany or in some cases replace the grayscale scanned image that would 
otherwise be generated by USPS mail imaging processes (or, in the case of flats, replace the “image not available” 
notification) and provided to participating consumers as Informed Delivery notifications. 

“Content” as used herein includes Ride-along Images, Representative Images, interactive links (URLs), and a Brand 
Display Name as text, or any other content that you provide to USPS by any means whatsoever (including but not 
limited to email, upload through PostalOne!, the Mailer Campaign Portal, or otherwise). 

By submitting Content to USPS in connection with any Informed Delivery Campaign, You agree to the terms and 
conditions specified below and to faithfully comply with all other rules, regulations, technical specifications and 
requirements for Informed Delivery Campaigns. The Postal Service reserves the right at any time to change or amend 
the Agreement, i.e., these terms, conditions, and notices under which this feature is offered. You may review the most 
current terms and conditions of use at https://www.usps.com/business/informed-delivery.htm. If You do not agree to, 
or cannot comply with, the Agreement as amended, You must stop using the feature. You will be deemed to have 
accepted the Agreement as amended if You continue to use the feature for Campaigns. You acknowledge and agree 
that Your use of the feature, in each instance, is subject to any such changes and that Your use of the feature 
constitutes acceptance of such changed terms. You agree to review this Agreement from time to time to ensure 
compliance with these terms and conditions. 

In addition, USPS is beta testing a new Informed Delivery feature in select markets that allows Mailers to provide 
digital offers and/or anonymized mail to customers You have not mailed to directly. For eligibility and requirements, 
see the Beta Test for USPS Informed Offers Powered by Informed Address below. 

Eligibility 

Informed Delivery Campaigns must be submitted to accompany a letter-size mailpiece or flat-size mailpiece that 
meets all mailability requirements of the Domestic Mail Manual. USPS reserves the right to refuse an Informed 
Delivery Campaign from a Mailer competing with a Postal Service product, service, or feature, although grayscale 
images of such mailpieces will be provided to consumers as part of the ordinary Informed Delivery notifications. 

Representative Images 

Representative Images are full color images submitted by the Mailer that can be displayed in lieu of the grayscale 
scanned image of a letter-sized mailpiece or in lieu of the “image not available” notification that would accompany a 
flat-size mailpiece (e.g., catalogs, magazines) in the USPS Informed Delivery daily digest email notifications, 
dashboard, or app. Representative Images must comply with the following requirements: (1) the Representative Image 
must be: (a) a reproduction of the address side of the mailpiece without an address showing, or (b) the non-address 
(obverse) side of the mailpiece; and (2) for flat-sized mailpieces required to be or that are mailed under covers or 
wrappers, the Representative Image must be an image of the Mailer’s corporate logo. Representative Images must 

https://www.usps.com/business/informed-delivery.htm
https://www.usps.com/business/informed-delivery.htm
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also comply with all technical requirements (e.g., format, file size, pixel width and height, etc.) and other specifications 
as disseminated by USPS. 

Ride-along Images and Interactive Links 

Ride-along Images are required for all Informed Delivery Campaigns. Ride-along Images are full color images that 
accompany either the Representative Image selected by the Mailer in accordance with the requirements above, or the 
grayscale image of the scanned mailpiece in the USPS Informed Delivery email notifications or dashboard. Ride-along 
images must comply with the following requirements: (1) the Ride-along Image must directly relate to the promotion or 
offer contained in the mailpiece; (2) the Ride-along Image must be sized to the full space allowed or be reduced in 
size based on the ratio compared to the Representative Image; and (3) regardless of Mailer identity, the Ride-along 
Image language may not facilitate diversion from Postal Service products, services, or features (including “pay online” 
and similar CTAs). 

URLs and interactive links submitted as part of the Content with Ride-along Images must comply with the following 
requirements: (1) all URLs and links submitted as Content for an Informed Delivery Campaign must be submitted as 
https; (2) all URLs and links submitted as part of an Informed Delivery Campaign must lead directly to a landing page 
directly associated with the physical mailpiece utilized in the Campaign; (3) all URLs and links must be free of any 
malware, viruses, errors, or other aspects that could negatively impact the Informed Delivery feature and/or consumer 
experience with the feature; (4) You must monitor the Campaign and any threats, vulnerabilities, malware and 
malformed links must be addressed and reported to USPS within twenty-four (24) hours of discovery; and (5) any web 
site being linked to from an Informed Delivery campaign and/or USPS.com shall be branded in a manner or have a 
look and feel (“trade dress”) that will not emulate USPS.com or create a likelihood of confusion with USPS trade dress 
or otherwise lead consumers to believe or confuse consumers that they are on a USPS site. To comport with USPS 
policies related to exit pages, and with the goal of not having an exit page, You acknowledge, understand and agree 
that the standard for no exit page as set forth by Postal Service Management is that the site being linked to needs to 
be substantially different from USPS sites (i.e., the site’s appearance must be one that a person is unlikely to confuse 
with USPS sites or properties, or to think is a part of the USPS websites or properties, and possesses a distinct look 
and feel from those of USPS sites or properties, and the site must have a distinct URL separate and apart from the 
URLs of USPS.com and not use any USPS marks). 

Your Representations and Warranties 

You represent and warrant that You have all necessary rights, including third party rights, and hereby grant to USPS 
such rights to use, display, publish, transmit, distribute, and make copies of the Content, and otherwise use it in Your 
Informed Delivery campaign, without infringing any rights of any third party or violating any applicable laws, rules, or 
regulations. The rights referred to in the foregoing include, without limitation, copyrights, trademark rights, rights of 
publicity (name and likeness rights) and any other rights necessary to use the Content. You further represent and 
warrant that the nature, appearance, and display of the Content is consistent with the mailability requirements of the 
Domestic Mail Manual. 

You acknowledge and agree that USPS will not be involved in any way with the design of the Content, and represent 
and warrant that the Content as submitted to USPS or uploaded through USPS portals complies with these Terms and 
Conditions and any requirements published by USPS on PostalOne!, the Mailer Campaign Portal, or the Interactive 
Campaign Guide (available at https://www.usps.com/business/informed-delivery.htm), or elsewhere on that site. You 
agree to evaluate and bear all risks associated with the use of any Content and agree that You are solely responsible 
for and assume all liability arising from use of the Content in or through or otherwise as a result of Your Informed 
Delivery campaign. You represent and warrant that the Content does not claim or create the impression, whether 
expressly or by implication, that the Postal Service endorses You or Your product, service or offering, and that the 
Content does not contain unlawful or legally actionable material, such as Content that is fraudulent or misleading, is 
defamatory or obscene, or violates anyone else’s rights, including copyright, trademark, or privacy or publicity rights. 
You agree that the fact that USPS reproduces, displays, or distributes the Content and/or otherwise uses it in the 
Informed Delivery campaign: (1) does not constitute approval or endorsement of the Content; (2) does not indicate 
that the Content complies with any or all applicable laws, including Postal law or regulations, or (3) does not constitute 
acceptance of any liability or risk arising from the Content. For any interactive link contained in the Content, in addition 
to representations and warranties above, You warrant and represent that any web page linked to directly from 

https://www.usps.com/business/informed-delivery.htm
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Informed Delivery, whether through an email notification, dashboard or mobile app, shall not take Informed Delivery 
users to a web page that could be confused by a reasonable person to be a Postal Service web page. 

Indemnity 

You agree to indemnify and hold the Postal Service and its Governors, officers, employees, agents, printers, 
contractors, vendors, and suppliers harmless against any and all expenses and losses of any kind (including 
attorneys’ fees and costs) incurred in connection with any claims of any kind arising out of breach of any of the above 
representations and warranties, and publication, transmission, display or distribution of the Content (including, without 
limitation, any claim of patent, trademark, or copyright infringement, libel, defamation, breach of confidentiality, 
misappropriation of trade secret, invasion of the rights of privacy or publicity (including the right to control use of one’s 
name and likeness), or false or deceptive advertising or sales practices) or any material or products of Yours to which 
third parties can link through the Content. 

Rejection/Cancellation of Campaigns 

USPS reserves the right to reject or cancel any Informed Delivery Campaign at any time for any reason satisfactory to 
USPS in its sole and non-reviewable discretion, including but not limited to the following: (1) violations of or 
noncompliance with any of these Terms and Conditions, or requirements published via PostalOne!, the Mailer 
Campaign Portal, or in the Interactive Campaign Guide, or on https://www.usps.com/business/informed-delivery.htm ; 
(2) detection of potential threats, vulnerabilities, malware or malformed links, security or privacy concerns, or potential
degradation of USPS or consumer systems or equipment; (3) Campaign interactive links that are broken or that
resolve to pages that negatively impact the Informed Delivery user experience; or (4) potentially subject USPS to
liability or risk damage to the Informed Delivery feature and goodwill associated therewith.

Disclaimer 

THE PRODUCTS, SERVICES, WEBSITE, CONTENT AND/OR MATERIALS AVAILABLE THROUGH USPS ARE 
PROVIDED ON AN "AS IS" AND "AS AVAILABLE" BASIS AND WITHOUT WARRANTIES OF ANY KIND, EITHER 
EXPRESS OR IMPLIED. 
USPS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ARISING FROM A COURSE OF 
DEALING OR PERFORMANCE, NONINFRINFGEMENT, OR TRADE USAGE. USPS SHALL NOT BE LIABLE TO 
YOU OR ANY OTHER PERSON OR ENTITY FOR ANY LOSS, COST, DAMAGE OR EXPENSE, INCLUDING 
WITHOUT LIMITATION LOSS OF PROFITS, ARISING OUT OF OR IN CONNECTION WITH ANY CONTENT 
INCLUDED IN INFORMED DELIVERY, THE MANNER IN WHICH ANY CONTENT IS DISPLAYED OR 
DISTRIBUTED, THE FAILURE TO DISPLAY ANY CONTENT, OR ANY TECHNICAL MALFUNCTION, COMPUTER 
ERROR OR LOSS OF DATA OR OTHER INJURY, ARISING, DIRECTLY OR INDIRECTLY, FROM YOUR USE OF 
THE INFORMED DELIVERY FEATURE. SPECIFICALLY, AND WITHOUT LIMITING THE FOREGOING, USPS 
DOES NOT REPRESENT OR WARRANT THAT ANY CONTENT WILL BE DISPLAYED OR OTHERWISE 
TRANSMITTED OR DISSEMINATED THROUGH INFORMED DELIVERY WITHOUT INTERRUPTION OR ERROR. 

Limitation of Liability 

IN NO EVENT SHALL USPS BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR 
EXEMPLARY DAMAGES, EVEN IF SUCH DAMAGES ARE FORSEEABLE, AND REGARDLESS OF WHETHER 
USPS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOUR SOLE AND EXCLUSIVE REMEDY 
FOR ANY CLAIM ARISING FROM OR RELATING TO YOUR PARTICIPATION IN AN INFORMED DELIVERY 
CAMPAIGN SHALL BE LIMITED TO A MAKE-GOOD PLACEMENT OF THE CONTENT AT A LATER TIME IN 
CONNECTION WITH A SUBSEQUENT MAILING. 

Governing Law 

Any and all disputes involving these Terms and Conditions or arising from the submission, rejection or cancellation of 
an Informed Delivery Campaign shall be governed by federal law, with jurisdiction and venue exclusively in the United 
States District Court for the District of Columbia or the United States Court of Federal Claims, as appropriate. 

https://www.usps.com/business/informed-delivery.htm
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USPS INFORMED OFFERS POWERED BY INFORMED ADDRESS BETA TEST 

THESE TERMS ARE SOLELY APPLICABLE TO MAILERS THAT HAVE FILLED OUT THE PILOT PERMISSION 
FORM FOR INFORMED OFFERS 

This Beta Test Agreement (this "Beta") is a legal agreement that sets forth the terms and conditions for your use of the 
Informed Delivery service’s Informed Offers Powered by Informed Address during the Beta Testing period (the "Beta 
Test"). This Beta is concluded between You and USPS only, and USPS is solely responsible for the services, content 
and materials provided through the Beta. User acknowledges and agrees that he, she or the entity You represent has 
accepted the Beta and is solely responsible for and shall abide by these Beta terms. Participants in the Beta Test are 
subject to the following Terms and Conditions as well as the Mailer/Submitter Obligations Regarding Supplemental 
Content and the main Term and Conditions provided above. 

Description of Beta 

Participation in the Beta Test enables Your campaign in select ZIP Codes to be viewed and acted upon by Informed 
Delivery users that were not on your mailing list and did not receive a mailpiece from You. At present the Beta Test is 
only available in 28 Northern Virginia ZIP Codes served by the Postal Service’s Merrifield VA facility. Provided that 
Your campaign is being mailed into some or all of these ZIP Codes, if You participate in the Beta Test, all Informed 
Delivery users within those ZIP Codes that have elected to participate in the Beta Test and selected a marketing 
preference category corresponding to Your campaign will have the opportunity to view and act on the digital offer 
contained in Your campaign. In addition, if a participating user expresses an interest in receiving marketing mail 
corresponding to the preference category of Your campaign, You will have the opportunity to send mailpieces to that 
user utilizing a newly developed anonymized mail service (“Informed Address”). In the case of Informed Address 
mailings, Your mailpiece will utilize a coded mail barcode without any of the user’s personal information being shown 
on the mail piece or being divulged to You. You must execute a separate Pilot Participation Form for each of Your 
Informed Delivery campaigns that you wish to be included in the Beta Test. 

No Guarantee 

You acknowledge and agree that the Beta Test is a test that may not be free of errors. Being a test, You agree that 
the Postal Service does not guarantee the Beta, nor does the USPS assume any liability for the content of offers 
provided through the Beta. You agree to hold the Postal Service harmless from any errors, non-receipt of offers or the 
actions or inactions of any users participating in the Beta Test. 

Evaluation and Contact during the Beta 

You acknowledge and agree that the Postal Service may send emails to You as a participant in this Beta Test, and 
participation in this Beta Test authorizes the Postal Service to do so. You agree to receive email requests from USPS 
to evaluate and provide feedback about the Beta Test, or direct mail surveys asking You to evaluate the Beta Test. 

You acknowledge and agree that USPS will not be liable for any costs or damages incurred by You or any other entity 
in relation to this Beta based on Your participation in this Beta Test. 

In any instance where You contact the Postal Service regarding the Beta Test, You grant the Postal Service 
permission to use any information, suggestions, ideas, drawings or concepts communicated for any purpose by You to 
the Postal Service in any manner that the Postal Service chooses, commercial, public or otherwise, without 
compensation whatsoever. 

No Unlawful or Prohibited Use 

As a condition of Your participation in the Beta Test, you warrant to the Postal Service that you will not use the Beta 
Test for any purpose that is unlawful or prohibited by these Terms of Use. The Postal Service reserves the right to 
terminate User's access to the Beta Test at any time without notice for any reason whatsoever. 
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Expiration Date and Termination of Beta 

This Beta or Your participation in the Beta Test shall automatically expire at the conclusion of this Beta Test, unless (i) 
terminated by the Postal Service in its sole and unreviewable discretion prior to its conclusion, (ii) ordered by the 
Postal Regulatory Commission or a court of competent jurisdiction to terminate, or (iii) otherwise required to comply 
with subsequently enacted legislation requiring the Beta’s termination. USPS may terminate by either ending the Beta 
Test, removing YOUR access from the Beta Test or by providing You notice of the intent to terminate. You may not 
terminate the Beta prior to the end date submitted for Your campaign, but at any time You may cease participation in 
the Beta Test by declining to execute new Pilot Participation Forms in connection with Your Informed Delivery 
campaigns. You acknowledge and agree that You may continue to receive updates, emails or correspondence related 
to the Beta until removed from the Beta Test. In the event the Postal Service makes the Informed Offers feature a 
wide-spread and permanent service following the Beta Test, Your continued use of the service will constitute Your 
acceptance of the permanent service’s terms and conditions, which shall differ from the terms and conditions of this 
Beta. 

Equitable Relief 

User acknowledges and agrees that due to the unique nature of Postal Service’s proprietary information, including but 
not limited to information obtained from the Beta or any USPS Marks, there may be no adequate remedy at law for 
any breach of its obligations hereunder this Beta, that any such breach may allow User or third parties to unfairly 
compete with Postal Service resulting in irreparable harm to Postal Service, and therefore, upon any such breach or 
threat of such breach, Postal Service shall be entitled to seek injunctions and other appropriate equitable relief in 
addition to whatever remedies it may have at law. 

Notice Regarding Beta 

Except as otherwise provided, all notices that are permitted or required under this Beta shall be in writing and shall be 
deemed given when delivered by "First-Class Mail," addressed as follows, or to such other person or address as may 
be designated by notice by the Postal Service: 

Attn: Product & Innovation – Informed Offers Team 
U.S. Postal Service 
475 L'Enfant Plaza, S.W. Room 5607 
Washington, DC 20260 

Acceptance of Beta Terms 

You acknowledge and agree that You have read, understand and accept the terms of the entire Beta above and You 
represent and warrant that you are authorized to accept this Beta with the requisite corporate power to bind your 
business or You individually to perform the obligations hereunder. Your continued use of the Informed Offers feature 
and participation in the Beta Test constitutes acceptance of these terms and conditions. 

Updated: 07/16/2020


